
Readme_EN (Samplitude Pro X2)

10/07/2015 Samplitude 13.2.0.205

Import / Export / Playback / Recording

Metronome Pre-Count fix from build 176 can be deactivated with following ini-entry
[Setup] OldPrecountHandling=1
Issues with MTC sync - fixed
64 Bit version: dithering bug - fixed
Improved handling of  "Another stereo master out is used in this project" dialog

text adjustments
'Don't show this dialog again' now remembers the selection of 'cancel'

EN version: Issues with settings of resample export options - fixed
AAC import: Meta data is now being read
Problems with Take Manager after "Save complete VIP..." - fixed

Mixer/FX/Instruments

Vandal: diverse issues with Base setups (Loading of settings, Master volume control) - fixed
Missing visual update after using Spectral Cleaning in Wave Editing mode - fixed
Crashes when scanning  VST2-Plug ins - fixed
VSTi Manager did not show VSTi - fixed
FFT Filter, Vocoder, Denoiser, Dehisser: Issue with setting FFT mode and audio type - fixed

Automation

Paste and delete of object automation for all selected objects, not just the first
Typing values now works on multiple tracks

Hardware Controller

Eucon: 64-bit version change to SDK version 3.2.1
Crashes at import of old cps-files - fixed
Time display continued after stop of playback - fixed
Option "No fader update after release" didn't work - fixed

General

Usage of unsupported characters for creating of new sub folders didn't issue a warning – fixed (fix in build 174 was incomplete)
Grafic error while playback with soft scrolling – fixed
Problems with new docking after restoring backup projects  - fixed
Diverse crash fixes

05/21/2015 Samplitude 13.1.3.176

Import/Export/Recording

Problems with metronome precount - fixed

Mixer/FX/Instruments

Problems with copy protection of some plug-ins (e.g. iLok for Antares and older Waves plug-ins) - fixed
Current ReWire 2.6.4 DLLs in Customize\ReWire (just needed in case there are no ReWire DLLs installed yet)
Default shortcut Shift+Ctrl+F did open old 4 band EQ - fixed
Object editor: just activated gain was applied only after next playback start - fixed



GUI

Toolbar: time input for moving objects didn't work - fixed

General

Updated setup for visually impaired users (Setup_VisuallyImpaired.INZ)
Attention: in comparison to Samplitude Pro X several shortcuts changed
More details under: http://pro.magix.com/de/samplitude/barrierefreiheit.1454.html

04/24/2015 Samplitude 13.1.2.174

Mixer/FX/Instruments

Supplied Vita instruments might ask for activation on systems with dongle - fixed
AUX sends and new default EQ116 were calculated despite mixer FX bypass - fixed
Wrong status line display during plug-in selection  - fixed
Wrong caption of VST3 plug-ins - fixed
User defined VST path wasn't used for VST3 - fixed
No undo step for reset mono/stereo - fixed
Advanced Dynamics: reduction display didn't work  - fixed

Hardware Controller

No update of display after saving a setup with different name - fixed

GUI

Problems with touch displays 
Not all touch events were detected correctly  - fixed
On-screen keyboard could be shifted by touch - fixed

"Menu v11" didn't work anymore - fixed

General

Several adaptions for Alesis V49 keyboards
Select "V49" as MIDI input device
Supplied Vita instruments will use controller 20-24 (knobs 1-4)
Button 1+2 (controller 48+49) will step to previous/next preset while plug-in dialog is open 
Button 3+4 change MIDI channel of keyboard

hardware controller setup for simple control of transport and mixerSupplied  (play, stop, volume track 1-4)
A little example for using the drumpads can be found  in _Demo\Alesis V49 Drumpad Demo
Attention: V-Editor for V49 configuration should be set to "MIDIIN2 (V49)"

Incomplete time edit fields - fixed
No error message with invalid folder names when creating a new folder  - fixed
No overwrite warning when saving a project immediately after creation - fixed
"Insert silence" was applied twice in wave projects - fixed
Several crash fixes

02/03/2015 Samplitude 13.1.1.162

Mixer/FX/Instruments

Independence: keyboard entry did not work – fixed
Different display of Q value in mixer and EQ116 dialog – fixed
Multiple Outputs:

New Stereo Master handling
Stereo Master can now be selected additionally to corresponding output
Stereo Master will always be "primary" output 

http://pro.magix.com/de/samplitude/barrierefreiheit.1454.html


Master can be routed to multiple outputs with CTRL key
Displayed in Routing Manager 
Modified output menu

Busses are shown before devices
Output for Stereo Master only marked with "M"

"Show Output" for Mixer and Track Editor can be chosen independently (Only correctly displayed in Camo, Canis, Carbon,
)StarGray

Multiple Outputs independent from Bypass-switch in AUX section
With activated "Show outputs" active multiple outs are shown
Can only be deactivated one by one

Playback issues with multiple outs in in Economy-Engine – fixed
1 sample shift with multiple outputs in Hybrid Engine – fixed
Issues with solo handling – fixed
Issue with creating Aux Busses in mixer – fixed 

Request after loading of project with changed Stereo Master didn't work – fixed
Frequency display in Mixer and EQ116 differed when opened for the first time – fixed
CTRL + Click for multi-selection of plug-in slots didn't work – fixed
Missing object reverb with Room Simulator – fixed
Crashes with EQ116 – fixed
Plug-in handling for grouped tracks similar to grouped objects again activated by default (deactivate with [Factors]
MixerTransferAllFx=1 )
Issue with Snapshots in surround projects – fixed
TS/PS artefacts with élastique Pro – fixed

Automation

Option to consolidate volume curves when converting them from track to object
Missing shortcuts in automation menu – fixed
Issue when creating object curve points in Universal Mousemode at high zoom levels – fixed
Additional points are created at range borders for conversion of object to track automation (or vice versa)
Deleting object automation points did not create undo step – fixed
"Link curves to objects"  works now when deleting objects

MIDI

MIDI track Volume fader with CC07 function had been reset when undoing or not accepting recording takes – fixed
MIDI Editor: sometimes playback did not work – fixed
Screen Keyboard can be played also from an open VSTi dialog

Hardware Controller 

Crash when adding a hardware controller – fixed
EUCON: Crash when closing a project with plug-ins and activated EUCON controller – fixed
Fader scaling was not considered occasionally – fixed
Several other fixes

GUI

DPI scaling 
Only activated for more than 125% screen scaling
Issue with VCA Fader display – fixed

Improved keyboard shortcuts and tab order for track info dialog
Diverse GUI fixes for Object Editor (Canis, Camo, Carbon)
When switching between system and project preferences, all elements in dialog on the left side collapsed– fixed
Diverse docking issues with MIDI-Editor – fixed
Wrong program title after closing last project – fixed
Wrong size of grid toolbar – fixed
Diverse problems with keyboard focus – fixed
Display problems after program start or loading of workspaces – fixed
Object Editor: display in headline did not update – fixed
Docking: Issues with focus when working on multiple projects (project specific toolbars and calling up menus) – fixed
Track fader of inactive projects have not been displayed – fixed
Keyboard shortcuts including "ALT GR" did not work reliably – fixed



Issue with command "close docker tab" (CTRL+F4)  – fixed

General

Additional punch-out marker is set at range end
Issue with "Recall last position" after moving markers – fixed
No overwriting of album name when loading CD text file (*.cdt)  – fixed
Object buffer size is now limited within 1.024 and 32.768
Track bouncing: Setting for ignoring master and track effects have not been recalled correctly – fixed
Right/left arrow keys did not work when naming tracks – fixed
Export of keyboard shortcuts not in Read Only directory anymore by default
C&R Suite activation link was available in Pro X2 Suite – fixed
problem with hint for additional downloads in download version activated by dongle – fixed
Crashes at shutdown of program with open object editor  – fixed

 

 

04/12/2014 Samplitude 13.1.0.130 (Samplitude Pro X2 Download
Version)

Mixer/FX/Instruments

VST3: Plug-ins did not work before first play  – fixed
Plug-in handling for grouped tracks similar to objects can be activated with [Factors] MixerTransferAllFx=-1
Plug-in handling for grouped tracks equivalent to grouped objects
Copy&Paste buttons in plug-in dialog are now hidden
Elastic Audio: Crash when closing after opening TS/PS dialog – fixed
Spectral Cleaning: Issue when editing MP3 files – fixed
Issue with output selection in Track Editor – fixed

GUI

Issues with DPI scaling in Object Editor Max skins – fixed
Monitoring information: "Don't show this again" checkbox added
Wrong display after using "Waveform Generator" –  fixed
Docked keyboard did not receive keyboard focus after clicking – fixed
Issues with changing Workspaces while having project windows undocked – fixed
Closing dock affects project window – fixed
activated marker lock has not been displayed – fixed

General

Issues with saving sessions – fixed
Issues with clicking volume fader in arranger after selecting plug-in in Mixer – fixed
Keyboard shortcuts have not been displayed in tooltips – fixed
Issue when selecting areas in cut-mouse-mode – fixed

 

 

11/18/2014 Samplitude 13.1.0.123 (DVD-Release-Version)

Import/Export/Recording

"Show maximum amplitude" when exporting DVD-Audio did not work – fixed
For licencing reasons, MP3 export requires Windows Media Player 10 or higher to be installed
Bouncing of 32-bit files without RIFF64 format performed 2 GB split at wrong position – fixed



Option "Load file as wave project"
Batch processing: overlapped volume input – fixed 
Write AAC meta data supported
Casually white noise after recording with Pre-Recording – fixed
Wrong length information after HE-AAC export – fixed
Wave export format was reset from 32-bit float to 32-bit int – fixed
Track bouncing: 5.1+2 RF64, stereo master does not receive audio if project contains single outputs – fixed

Mixer/FX/Instruments

TS/PS
New zplane algorithms

élastique Pro V3
élastique Efficient V3

Old algorithms were removed, except Resample and Monophonic Voice 
Multiple outputs

Can be selected while pressing the CTRL key
Can be displayed and selected in the routing manager
Are routed by default like an "AUX send (post)" at the end signal path of a track, Output (pre) and Output (direct) available
via mixer or routing manager 
"No output" selectable
In the mixer by right mouse click onto the AUX button in the AUX section: view selection between AUX sends, multiple
outputs and side chain sends ( )skins adapted only for Camo, Canis and Carbon yet 
Primary output is shown in AUX-send section (read only)

Effect routing
EQ116 is used as default EQ, old 4 bands EQ is only used for old VIPs
Delay/Reverb can be used multiple times in a track
Effect dialogs didn't open when loading a VIP – fixed
Unlimited number of installed plug-ins (limitation of < 2.000 is removed)

VST3 support
Currently public VST3 folders are scanned automatically for plug-ins, 64-bit: "...\Program Files\Common Files\VST3", 32-bit:
"...\Program Files (x86)\Common Files\VST3"
There is no bridge for VST3 plug-ins. Since there is no safety measure during scanning using the bridge, the program might
crash with incompatible plug-ins.
In old program versions, VST3 plug-ins are handled like plug-ins that are not installed. That means they are loaded as
"inactive" in a project and are kept during save operations.
Known issues:

No sample-exact automation yet
Side chaining
Surround

Preset menu (seems to be supported by a few VST3 plug-ins only, e.g. Waves)
VST2

Issue with toggling inactive state with SHIFT-ALT if editor was opened – fixed
Waves VST2 Waveshell instruments (e.g. Elements Stereo) will now be recognized automatically (therefore scanning can
take longer)

VST-Scan default without system folders
Additional entry "Scan sytem VST folders" in plug-in menu  or VST system options
If scan is successful they will be scanned in the future too
Applies to VST2 and VST3, the VST2 sytem folder does not need to be specified as VST-Plug-in folder any more

Hide effect dialogs didn't work for some internal effects and VSTi – fixed
EQ116 

Surround Handling in Mixer and LFE initiiation
Bypassed EQ116 turned back on when loading a project – fixed
Loading of presets of 4 band EQ
EQ drag'n'drop in mixer didn't work – fixed

FFT Filter
Bigger graphical display when used as offline effect
Analyze and invert tool

Elastic Audio : "Synchronize tracks" copies the pitch change curve (relative difference) to all selected objects, which are at the same
time position. The objects in the active (selected) track are used as reference objects. 
Mixer

Flickering Drag'n'Drop Cursor – fixed
Shortcuts including Alt (e.g. Alt+S) did not work – fixed

Focus issues after "hide effects window" or closing of manager windows – fixed



Object editor: several issues when changing objects (e.g. switching from audio to a MIDI object) – fixed
Fade calculation independent of buffer size 

 DN-e1: new Synth 
Vita Solo Instruments

Pro X2: Bass Machine, Rock Drums, Vintage Organ
Pro X2 Suite: additional Analog Synths, Electric Piano, String Ensemble, Urban Drums

 
ASIO Hardware Monitoring

[Setup] AsioDirectMonitoringPanningLaw=-3 implemented e.g. for TotalMixFX
Also avaiblabe as INZ-Container:Customize\AudioEngine_HardwareMonitoring_PanningLaw_3dB.INZ
Enhanced functionality (also software monitoring without FX)

Support of new pan modes (2 channel panorama / volume)
Support of L->R, R->L
Support of AUX Bypass and panning

Wrong panning law in objects when loading old projects with 2 channel panorama – fixed
AM-Track: Playback issues after loading a project – fixed
Obsolete Dynamics effect removed from menu

Automation

New command: "Convert track automation in object automation curve" converts volume and panorama automation to object curves 
New command: "Convert object automation in track automation curve" converts volume and panorama automation to track curves

 Works with currently selected automation (volume/pan)  
Overwrite confirmation 

Copy automation areas
Copy and paste of object automation
Logarithmic volume scale in object
Shortcuts couldn't be assigned to "Select previous/next curve" – fixed
display of relative volume changes in tooltip
Correct dB scaling when moving several automation points
Convert object to track automation
Mode "Link curves to objects" now activates automation in target track automatically
Automation points can now be edited by right-click

jump to next point with Tab key
Mouse click on curve handle: sometimes the object behind was selected instead – fixed 
Moving curve handles: Curve is kept temporarily, even if a curve handle is moved to the lower end of a track. 
Change of automation curve when delete a range – fixed
When an object was deleted, the automation curve was kept – fixed 
No automation of the master EQ possible in the mixer – fixed

GUI

Screen Keyboard
Menu View -> Keyboard
For playing VST instruments, no MIDI output to external devices
Via mouse, computer keyboard or multitouch monitor
With arpeggiator (pre recording, arpeggios will be recorded)
Transpose buttons (can be controlled by keyboard arrow up/down)
Record start with Insert or Shift+R
Feature uses  and might be not available (depending on graphics card driver)QT/QML

 
 DPI adjustment

 file manager 
 (EQ116, FFT effects, ...)several effects dialogs

Object editor
Mixer
Transport console
Manager

Project docking
Projects are displayed as tabs 
Projects can be undocked from the main window
Except for main window, docking tabs will only be visible if more than one window or project is contained
For main window, this can be activated via ini file entry: [Setup] DockingAvoidTabbers=1 or
Customize\GUI_DockingAvoidTabbers.INZ



Toolbars
Only 2 toolbar sections (upper and lower)
New toolbar editor
User defined buttons with 400 icons for toolbars are supported
Old toolbar skins are supported (missing elements will be replaced with equivalent Camo or Canis icons)

added Track Editor button in Arranger
Updated instruments tuner with improved GUI and algorithms 
Minimal size of time displays reduced  
Issue with not visible or moved system options – fixed
Group name in objects could overlap audio marker – fixed

General

Change language via help menu
Track lock now prevents object from being deleted
New command View -> Zoom Into Selected Objects, also as button in the lower right part of the arranger
Double clicking a volume handle didn't work for multiple selected objects – fixed
Crashfix Crossfade Editor
System settings partly weren't applied when switching the settings page – fixed

New Samplitude Pro X2 Features based on Sequoia 13

New for Samplitude Pro X2

AAC-HE import/export (requires free activation)
SD2 import 
VCA Handling
Workspaces are not changed automatically any more, they have to be saved on purpose 
Samplerates > 96 kHz now accessable in drop down menu
Additionally for Samplitude Pro X2 Suite

sMax11 with option for True Peak Limiter
Loudness Metering

Compact Loudness Metering (EBU R128/ITU-R BS.1771)
Normalization of Master Fader

Cleaning & Restoration Suite (including Spectral Cleaning effect v1) 

Import/Export

AAC-HE export with advanced options 
 New VIP 

A newly created VIP will be saved immediately (e.g. to avoid wrong path settings)
Invalid characters could lead to issues when saving a vip – fixed
"Create new VIP" with space at the end of the project name could lead to issues – fixed
Name for new VIP YYYY-MM-DD
To prevent the change of the default path when create a new VIP, it's possible to create the following ini file entry 
[Setup] StaticNewVIPDirectory=1

TOC: "Sonic Style" and "Working order" are saved in the VIP (not as program setting as before)
AIFF: Better format compatibility, especially when using 32-bit Float and 24-bit
Crash with multi-channel FLAC files – fixed (only 2 channels will be imported)
Loading of wave files >2GB with defective Chunksize=0 – fixed
L/R file combination in one stereo object could get lost – fixed

Record/Playback/Engine

Hybrid-Engine: There is no limitation of the playback speed to 0.125 / 0.25 / 0.5 / 1.0 / 2.0 any more, any value can be used.
Metronome:

The metronome's output device will always be opened -> it's possible to activate the metronome while playback
Labeling the metronome output device in the device menu

Device menu was only able to display 128 mono devices – fixed (now 256)
Invalid input and output devices will not be corrected any more when loading a VIP



when closing the System Options, the user will be asked for correction of the devices
Mixer shows devices with red labels

Take name is now saved with the project
Issues during recording with activated Comparisonics – fixed
MIDI playback issues in 64-Bit-Version – fixed

 Mixer/FX/Instruments 

Free plug-in routing
There is no limitation in routing of internal effects and VST plug-ins any more. Any desired routing is possible.

Exception: Object AUX sends stay on last position.
Internal effects now can be used in multiple instances per object and track.

Exception: EQ, Dynamics, Distortion, Delay 
Surround effects order can be changed

Plug-ins in the separate channels are always calculated prior to the surround effects (that is incompatible compared
)to the old handling

Object panorama now uses the same dialog as track and AUX parameters
Advanced possibilities (Panning Law, Presets, Copy L->R, R->L)
Phase inverting now is calculated at the panner position ( )that is incompatible compared to the old handling
New pan modes on a track: 2 channel panorama, 2 channel volume,
but without automation, just like in objects (automation curve will be deactivated when using those new pan modes)

Annotations to compatibility of projects with older versions:
The first instance of an internal effect can be loaded in older versions.also 
The effect order can only be reproduced in certain cases.
Note about compatibility issues with version 12.5 

Mixer: drag'n'drop for effects now identical to objects
moving/re-sort: without modifier
copy: with CTRL

Surround
Panning Law is set as default mode
some bug fixes for load/save panning law presets 
With active Surround Master, multi-I/O mixer presets didn't work – fixed

Default TS/PS algorithm for objects can be set under System settings > Effects > Resampling/Bouncing 
Maximized project mixer was displaced by some pixels – fixed.
MAGIX Plug-ins sometimes could not store their presets (caused by missing writing permissions) – fixed
EQ116: 64-Bit version mad noises when using the shelving filter – fixed
Corvex: displays were mixed up – fixed
Option to "clear" buffers before bouncing/export for all plug-ins with 2 seconds of silence

this can take some time when many objects are in the project
can be enabled with [Setup] VSTBufferClearing=2000

Hardware Controller

ControlPanel 3
Eucon improvements, new SDK
Automatable parameters of internal effects can now be controlled similar to VST plug-ins
Surround Pan can be controlled by Hardware Controller. Parameter: Surround Pan (slot 1 = x, slot2 = y) 
"Simple Send" didn't work – fixed
When toogle between projekts, faders were reset to lowest position and updated to new value afterwards – fixed
HWC: Issues with with LED updates – fixed
Diverse fixes

General

New cursor command "To maximum peak for selected object": Play cursor is positioned at the peak value of selected objects in the
timeline.
"Link curves to objects" didn't work directly after program start when using shortcuts without using mouse – fixed
Track and object gain are considered for waveform scaling
Flickering mouse arrow at object toggle and open Object Manager – fixed
Faster toggle of workspaces
System options

Improved dialog switching in system options.  
New page in System Options Dialog named "Automation" (replaces old MIDI controller dialog)
Mouse System Options: Range Threshold was not saved



Menu configuration is saved in program-ini (_TB.ini is not needed any more)
Timestamp

File Manager: Auto refresh after timestamp changes in wave file
"Set original position": New timestamp is saved in wave file
Changed time stamp was sometimes not saved in wave file – fixed

By default less columns are displayed in Managers
Error message if ini file was write protected
Improved crash evaluation:

New dialog for inserting comments
Crash dumps will be sent immediately, if internet connection is available.

Removed from program
CPU Peakmeter removed
MP3 Surround removed
dB-grid in Arranger removed
DirectX removed
audioid removed
Old offline FFT filter
CD compare option is not displayed any more (can be reactivated by ini setting: [CD] EnableCDCompare=1)

 

 

ASIO Hardware Monitoring
[Setup] AsioDirectMonitoringPanningLaw=-3 implemented e.g. for TotalMixFX
Also avaiblabe as INZ-Container:Customize\AudioEngine_HardwareMonitoring_PanningLaw_3dB.INZ
Enhanced functionality (also software monitoring without FX)

Support of new pan modes (2 channel panorama / volume)
Support of L->R, R->L
Support of AUX Bypass and panning

Wrong panning law in objects when loading old projects with 2 channel panorama – fixed
AM-Track: Playback issues after loading a project – fixed
Missing bypass display in mixer for Encoder Preview – fixed
Obsolete Dynamics effect removed from menu
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